


Album

An album is a collection of Koan pieces.    The pieces could be your favourites or a collection you have 
bought from another artist, already conveniently supplied as an album.    When you buy a preconfigured 
album it comes with its own notes which you can read in the Viewer Module.    You can also add your own 
notes to your own albums, allowing you to jot down things you feel when you listen to its pieces. 

Opening an album takes a few seconds as each piece that is in the album must be read into memory 
before the album is ready to play.    Only the currently playing piece, however, is currently held in RAM 
once the album is fully loaded.

The album file has the .SKA extension. Albums can include Koan pieces with the .SKD or .SKP format or 
MIDI files.



Piece

'Piece', 'track', 'song' and 'soundscape' are all terms used by people to describe the music 
created by Koan when it 'plays' the special file that is generated by Koan Pro (the big brother
of Koan Plus)    When the file is plugged into the Koan engine (what we refer to as the 
software technology behind the Koan range of products) it generates the beautiful music 
that ensues. The piece file can either have the extension .SKP (encrypted) or .SKD (Koan Pro 
development file).



Encryption

Pieces written in Koan Pro can be encrypted so that others can not read them, offering a higher level of 
protection to those who spend time creating polished works.    Encrypted files have the file 
extension .SKP.      These can be played by Koan Plus as well as the non-encrypted files (developer files 
used by Koan Pro) with extension .SKD



Parameters

Parameters are the various types of variables Koan uses to control its output. 



Envelopes

Envelopes are a graphical way of displaying the way a parameter changes over time; they 
are analogous to a 'bar chart' in that the height of the bar is in direct proportion to the value 
of the parameter: the higher the bar the greater the value.    These can only be seen in Koan 
Pro.



Instrument

This can be any of the General MIDI patch numbers (including capital series i.e. 125.6) and these are 
identified by their patch number i.e. 098 FX2.    We currently support the standard drum set,    and these 
sounds are identified as the patch number preceded by a D, i.e. D60.    You can assign any number of 
instruments to a voice, more about that later.



Voice

A voice in Koan terminology is a 'player', and each player is assigned an instrument.    You can have as 
many voices defined as you want.    Your sound card/synth provides the only real limitation on how many 
can play at once. You can label each voice (to identify them) with any name you want; in the demos the 
names are mostly the instrument type.    This is handy when you want to use different samples on an 
external synth/sampler.



General MIDI

General MIDI is a standard adopted by many manufacturers where there are 128 patches which have 
pre-defined numbers.    This allows MIDI files to sound roughly the same when they are played back, no 
matter what General MIDI soundcard/ synth is used to play them on.    For instance, patch no 19 will 
always be a Rock Organ sound (or nearest equivalent) no matter what the card. 

Note: Some cards do not actually provide the full complement of 128 sounds, in which case the 
manufacturer will generally provide a MIDI Mapper patch map which diverts those patch numbers to their 
nearest equivalent.



Module

Koan Plus uses a number of stackable modules, rather like a Hi Fi system.    Each module provides extra 
ways of viewing or hearing Koan music and each one can be hidden or made visible as required.    There 
are 4 modules in Koan Plus; the Main Control module; Player module; Viewer module and Analyser 
module.





SSEYO 

"SSEYO - the world leader in computer created ambient musics"

The company SSEYO (pronounced SAY-OH) was established to respond to the ever increasing demand 
for quality of life and personal fulfillment.    If you want to know more about the company or its products, 
have any ideas as to what you would like us to develop next or suggestions as to how we may improve 
our products, please do contact us at:

SSEYO Ltd
P.O. Box 29
Beaconsfield
Bucks
HP9    1EB
UK

Internet: koaninfo@sseyo.demon.co.uk
CompuServe 100317,302

Tel: +44 (0) 1494 671257
Fax +44 (0) 1494 671258

or, contact one of our distributors given in the accompanying README.TXT file or documentation.

Please note: Support on this product is provided through our distributors.



 Introducing Koan Plus

Welcome to SSEYO™ Koan™    Plus.

Koan Plus is a revolutionary and trendsetting new addition to your desktop.    

Beautiful ever-changing Ambient mood music is now possible on YOUR own PC......
.....your PC need never sound the same again.    .

Koan Plus has the power to help create the moods you want in your environment and thereby actually do
something for you that is intriguing and intangible.    Through Koan Plus you can experience ever-
changing musical 'pieces' or soundscapes.    Because the pieces never necessarily repeat they do not 
have the same boredom or irritation factor as do MIDI sequences or WAV files, or indeed any other form 
of pre-recorded music.

The output Koan Plus creates is ideally matched to the new forms of software - 'Zen Ware'- that are 
starting to appear on the market. We prefer the term 'Mood Ware' for Koan Plus, as it can also produce 
exciting explorative music as well as the more relaxing material.    In fact, Koan is a Zen word which 
means a puzzle or mystery with no logical solution.    There is a famous 'Koan' which goes like this:    if 
you clap two hands together you get the sound of two hands clapping.    What is the sound of 1 hand 
clapping?    Our music is well suited to this description as it never repeats itself (unless specifically 
requested to do so) and so it is never really quantifiable.    A direct result is that it never really exhausts the
listener: it is like an ever flowing stream.    Our own Koan is therefore, what is the sound of computer 
created music?

Koan Plus's ambient music (or MIDI file recordings of it) can be used for any number of purposes and in 
all manner of places, e.g. personalisation of your computer with your own pieces, multimedia projects, 
aural enhancement to screensavers, film and video tracks, adding spice to presentations or simply used 
as a non-intrusive background to 'boring' databases or other similar applications.    It could even be used 
in malls, elevators, chill out rooms, raves, hospitals, alternative health centres, greenhouses - you name it
(refer to discussion on copyright).    

Koan Pro is the authoring system used to create the pieces that you can play with Koan Plus, more 
details are provided in the Koan Plus help file.

Koan Plus concepts - how does it work?
Music has traditionally been thought of as being something that is composed and has a beginning and 
end, and is thus 'pre-defined'.      A typical piece.    It is true that improvised music, music generated on the 
spur of the moment, can capture a certain freshness and    dynamism which pre-composed and pre-
rehearsed music can sometimes fail to deliver,    but you have no control over it, and you need to be a 
very accomplished musician to be able to play it or make it sound good.    In fact, you need to be in a 
special room full of musicians!    

The closest analogy to the Koan  series of products is that of an Aeolian harp, where the wind 'plucks' its 
strings in an uncertain and changing manner, thus producing a fairly 'ethereal' music.    Similarly, it could 
be seen as the aural equivalent of a log fire - we all know how entrancing it is to look into a glowing, 
burning fire.    The type of music Koan Plus creates would be difficult to make with a normal sequencer 
package because of the depth and variety of the changes it can manage, i.e. every second Koan can 
send out many fine changes in the musical balance which would take an age to enter into a sequencer.    
These changes help to geive the msic its subtlety and authenticity.

Mozart developed a system of automatic composition which required the use of a fairly large set of 
(generally short)    musical phrases of a fixed length.    He would roll a dice to determine in which order he 



should string them together.    The result was generally quite reasonable, but fairly limited in expression.    
Most auto-accompaniment and auto-composition software for the PC uses this technique which leads to 
very style based songs, with no where near the smoothness of Koan Pluss output.    Their output is 
generally also very rhythmic and so not as suitable for creating soothing, flowing music and nor does it 
have as much expression as does Koans output.

Koan Plus does not use the rolled dice principle at all to create its music.    It uses a large number of 
specially designed variable controls (over 80!), the values of which are written into the piece by its author, 
to change the notes and melodies played in special ways.    Our controls allow the creation of music that it
smooth, non-intrusive, and natural sounding.      When you play back a Koan piece in Koan Plus it 
interprets all the information there and then.    It thus generates music that is fresh and has never been 
heard before.

Koan Plus and its derivatives are revolutionary and are the next step forward in computer generated 
music.    The software really does allow you to play music that could go on forever, yet never repeat.    

Koan Plus is easy and fun to use

The real beauty of Koan Plus is that it is so fun to play with.    Not only fun to use, but easy to use too.    
The standard Windows user interface that you see whenever you use a Windows type program means 
that you don't have to guess where to find everything, as you would in a old DOS type program. 

We have provided special LED displays to show you how the music is changing as it plays; these show 
you the general frequency spread of the notes being played together with the MIDI channel output, for 
those more technically inclined.    They can be quite mesmerizing to look at.

There is also a comprehensive easy to understand on-line help system talking you through everything you
need to know together with Quick Tutorial to get you started (click here to go to it now).

Koan Plus's uses

Your Koan Plus pieces can be used in so many places to provide a comfortable atmosphere.    Places like
waiting areas, receptions, swimming pools, museums, art galleries, homes, greenhouses, kennels and 
yes, even elevators!!    We all know that people are not generally fond of Muzak.    This is often because it 
is a poor rendition of a song they know and love and because often the same song plays again and again.
Because Koan Plus does not reproduce music or songs already recorded, and it does not repeat in this 
way, it has a more soothing and relaxing effect on people. 

Because of the way Koan  has been written, pieces of considerable length can be created for Koan Plus.
For instance, a piece could be created that could play for 24hrs all the while changing instruments and 
parameters throughout this period.    This piece could respond to the different times of day, being quiet 
and still in the morning and get louder and    more complex by lunch time, say. 

Koan Plus and General MIDI

As Koan Plus supports General MIDI your piece will have access to many special effects and ways of 
manipulating sounds if your sound card supports General MIDI too. 



Comparing Koan Plus

Koan Plus is a software program which creates ever-changing musical montages that are generated in 
real-time as you listen to them.    You can think of Koan Plus as being analogous to a record player or a    
CD player with the notable difference that Koan Plus creates music on the spot - it does not play back 
pre-defined, 'frozen'    pieces of music.    

Koan Plus is different from PC auto-accompaniment, auto-composition and sequencer programs 
currently available for the reasons below:

Feature Koan 
Plus

Auto- accomp- 
animent

Auto- 
composition/ 
Algorithmic

Sequencer Performance

Specifically designed to produce
flowing, ever-changing mood 
music

YES no no no no

Harmonious pieces that can 
play forever without any 
repetition

YES no some no no

MIDI file recording of output 
allowing you create lots of 
multimedia content quickly

YES some some yes some

Authors committed to creating 
many more pieces for your 
listening enjoyment

YES yes (styles) no yes (MIDI files) unknown

Great looking MIDI channel and 
Freqency displays

YES some no no some

Output changes with time of day YES no no no no

The only product on the market 
doing what it does

YES no no no no

Is ideal for non-musicians and 
musicians alike

YES no no no no

Encrypted play files protect 
authors work

YES no no no unknown



Copyright, licensing and ownership discussion

Important: SSEYO provides no warranties whatsoever as to the accuracy or legality of the 
statements provided below.    We recommend you should consult your lawyer should you have 
any doubt about your ownership of Copyright on recordings you may make.    See also the 
software license.

Copyright
We are keen to bring to the multimedia market a way of creating good quality music that is copyright free, 
but copyright law is a very complex area.    Computer generated music is currently a hot topic in Copyright
circles and there are no real precedents set either way.    The wording of the UK Copyright, Designs and 
Patents Act 1988 states that the owner of a copyright in a musical work is the person that created it, 
whereas this contrasts with computer generated musical works where the owner of the copyright in the 
work is the person by whom the arrangements necessary for the creation of the work are undertaken.    In 
our efforts to bring about copyright free music we have designed Koan Pro so that we allow the author of 
a Koan file (also variously refered to as the Koan piece, created in Koan Pro, which is interpreted by the 
Koan music engine to create the music) to state explicitly what rights they are prepared to relinquish.

The originator of a Koan file/ piece (the .SKD or .SKP file created in Koan Pro) is 
the owner of the copyright on that piece
Just as a Record Company can sell you a record or CD on which their artist's song is recorded, the 
originator of a Koan file can provide a floppy disk containing their own file/piece(s). Although you DO own 
the record or floppy disk once you have purchased it, you DO NOT own the actual song or file itself; nor 
(for the record or CD) do you own the 'recording' of that song: in effect YOU are purchasing a licence to 
use or listen to that particular song or Koans interpretation of the file YOURSELF. The Koan file is a 
literary work and so enjoys the full protection of International Copyright law. 
(Note: the reason a person has to pay the Performing Rights Society a fee when playing pre-recorded 
music in public is that a large number of people are listening to it, and not just you).    Licensing software 
for use is the normal situation for software, and the originator of the software is the copyright holder under
International Copyright law.

MIDI file recordings of Koan output 
So, purchasing a floppy disk containing a Koan file does not mean that you then own the copyright to that 
and, because you don't own it, you are not allowed to make copies of that file and resell these copies (but
like with a record you are allowed to make a 'backup' copy for your own personal use).    However, if you 
record the output from yours or someone elses Koan file (and if the original author relinquishes 
any present or future rights to or title they may have to all MIDI file or other recordings of their 
pieces, and this is an option to which they agree or not) we believe you own the copyright on that 
recording.    As the Koan output is different each time a file is played, you can make a master recording 
of it each time it plays which no one else will ever be able to make, so you can own the copyright on that 
recording.

Note:    MIDI file recording is disabled in the Koan Plus Demo version.
Note:    The situation may be unclear on who would owns the copyright on recordings of a piece that 
contained recognisable musical fragments of another artists work.    This could occur if the author of a 
Koan Piece included musical seed phrases that were the copyright of another artist.    There are also 
further complications of MIDI file recordings of computer generated music on which we are seeking legal 
advice.

What is the benefit of this to you?
We believe it means you can use ROYALTY FREE (because you own the copyright) any MIDI file 
recording you have made of any Koan piece (subject to author giving consent, as above) for any 
application you may desire.    All we require is that you note somewhere prominently in your 
application, accompanying documentation or materials that the music was created by the SSEYO 



Koan product. 

If you are the originator of    a Koan file then, as stated, you may not have any claim to copyright on the 
output, but you may record one or many instances of that output and you own the copyright to that (those)
specific recording(s).

Live output from Koan
Our standard license (one that comes with this package) allows you to use the product for personal use 
where the    Software is 'in use' on a computer when it is loaded into the temporary memory or installed in 
the permanent memory of that computer..    However, we specifically preclude use of this software in an 
unattended mode of operation for any purpose whatsoever, other than for personal use.    We also 
preclude use for public broadcast.

This means you can use Koan for all your daily personal requirements whatever they may be.    But, if you
want to use any Koan product in an unattended form (i.e. no-one is regularly attending it) for non-personal
use (i.e company or business) you will need a special license from us.

Examples: Use covered by standard license

Attended use
Personal 
Live Koan personal background music on your work/ home computer Yes
Creating your own Koan pieces Yes

Non-personal (i.e. used by or for business)
Presentations with live interactive Koan background (loaded with presentation) Yes
Live use at gigs, DJ work, performances Yes

Unattended use
Personal
Let your pets listen to it all day long Yes
Put it in your greenhouse for the plants! Yes
Wake up to it in the morning Yes
General music around the house Yes

Non-personal    (i.e. used by or for business)
Sending out Product Demo disks with live Koan background music No
Live Koan music for telephone hold systems No
Live Koan music for hotel foyers, reception rooms, lobbies, rest areas No
Live Koan music for environmental control systems (hothouses, buildings etc.) No
Live Koan music for broadcast (radio stations/ in flight rest music etc.) No

SSEYO would be pleased to discuss our licensing terms with you for Unattended, non-personal use, as 
outlined above.



Koan Pro

Koan Pro is the sophisticated Authoring System provided by SSEYO to create the pieces that you can 
play in Koan Plus.

You dont have to be a musician to have a great deal of fun and satisfaction in using Koan Pro
You dont need a musical keyboard
You could find you end up learning a lot about music!
Your PC will never be able to thank you enough for giving it a voice
Use it to create ever-changing music for your Multimedia presentations, or
Save the output to a MIDI file if you need precise timing
Knock up rich ambient pieces in record time, and save the output as a MIDI file to be used in your

favourite sequencer for the basis of your next hit song
Make your own pieces with the view to selling them to others - even if they dont have Koan Plus 

or Koan Pro they can hear them in Koan Plus Demo which you can ship with them (it comes with Koan 
Pro).

A few features:
Envelopes for a number or parameters makes it easy to create subtle effects
Real time control of parameters for quicker piece authoring
Encrypt the files for extra protection so that no one can copy what you have done
Put your copyright notice in the pieces and
Choose whether people can record your files and whether you relinquish your rights to recordings

made of your works
Draggable elapsed time piece marker for easy prototyping
Cutting and pasting of parameters and envelopes
Set the max time that you want a demo piece to play for (independent of the pieces actual length)
A host of parameters for you to control the sound of your piece (over 80)
Input musical seed phrases into the piece around which it will compose
Make musical lines mutate over time, creating moving melodies
Many controller values from which to choose

Each of the pieces it creates contains a number of voices, and each voice plays an instrument. The sound
and output of each voice is controlled by a number of parameters which can be given envelope values so 
that they vary in a controllable and predetermined way over the life of the piece. The notes that each 
Voice plays are governed by various rules as well.

Should you want further details please contact SSEYO directly at:

SSEYO Ltd
P.O. Box 29
Beaconsfield
Bucks
HP9    1EB
UK

Internet: koaninfo@sseyo.demon.co.uk
CompuServe 100317,302

Tel: +44 (0) 1494 671257
Fax +44 (0) 1494 671258



or, contact one of our distributors given in the accompanying README.TXT file or documentation.

Please note: Support on this product is provided through our distributors.



Koan Plus Demo

Koan Plus Demo is a slightly cut down version of Koan Plus.    It is only to be used for demonstrating 
Koans abilities.

Koan Plus Demo has the following limitations over Koan Plus:
No MIDI file save
No editing or saving of albums
Plays for 10 minutes before you get a message telling you it will stop playing in another 5 

minutes.    When those 5 minutes are up it will then stop playing.    You can restart it by pressing play.
Only 5 sample pieces, each having a shortened play time

If you purchase Koan Pro you may create some fantastic pieces you want to sell to or share with others 
(or you are really excited about the Koan technology taking the world by storm, as are we), and you now 
have something, Koan Plus Demo, to send to them so they can hear it/ your files for themselves.    We 
would really appreciate if you pass this around or load it up to various bulletin boards to which you may 
belong.    The only proviso is that you MUST distribute (depending in which format you received it) a copy 
of the original zip file (which contains all the necessary sub-files) or if not in zip format all the files supplied
with it when you got it (all the files that come as part of the install routine); and you are NOT allowed to 
distribute any of the Koan files, MIDI files, Albums or recordings that come with the Koan Pro or Koan 
Plus packages.    You can distribute your own pieces as you wish; in fact, you may wish to take advantage
of Koan Plus Demos limited play time (see above).    Or, you can use Koan Pro to set the play time of any 
piece you write such that the piece stops playing before its scheduled time.    This is useful for creating 
demo pieces which allow the listener to get a taste of the piece before they purchase it - a hear-before-
you-buy approach..



Koan Plus V1.0

Koan Plus V1.0 is the good looking front end that allows you to make albums of your pieces and then to 
play them back with various graphical displays (and has full implementations of the features modified for 
the demonstration version, Koan Plus Demo).

Koan Plus full product comes with the following:
10 Koan pieces and 10 MIDI file recordings of these pieces, provided on a 3.5 HD floppy disk.
10 Studio mastered mood music tracks, recorded whilst saving the Koan pieces output to the 

MIDI files above, provided on audio CD - plus a bonus audio track.
12 page booklet and registration card.

The full (i.e. not demo) version of Koan plus also allows MIDI file recording of Koan pieces and you can 
add/ edit albums.    It will not stop playing after 15 minutes and the pieces supplied with Koan Plus will 
play for their full time, and have not been shortened as have the pieces that come with the Koan Plus 
Demo software.

Future versions of Koan Plus will have yet more additional functionality.

Should you want further details please contact SSEYO directly at:

SSEYO Ltd
P.O. Box 29
Beaconsfield
Bucks
HP9    1EB
UK

Internet: koaninfo@sseyo.demon.co.uk
CompuServe 100317,302

Tel: +44 (0) 1494 671257
Fax +44 (0) 1494 671258

or, contact one of our distributors given in the accompanying README.TXT file or documentation.



Support/ serial number/ registration

No support is provided on the Koan Plus Demo version!

However, if you purhcase a full product support is provided through the dealer or distributor from whom 
you bought the product.    You will need to quote your serial number, which is to be found on your Koan 
Plus booklet as well as on the registration card which you should send back to us (please!).    Support 
should be a good reason to make sure you complete and send off your registration card today!    Please 
see the README.TXT file supplied with Koan Plus for the up to date list of our distributors.

See also
SSEYO



License Agreement

ATTENTION:      THIS IS A LICENSE, NOT A SALE.      THIS LICENSE IS GRANTED FOR 
DEMONSTRATION PURPOSES ONLY.

IMPORTANT NOTICE: CAREFULLY READ THIS LICENSE BEFORE USING THE SOFTWARE AND 
ACCOMPANYING DOCUMENTATION.    BY USING THE SOFTWARE YOU ARE AGREEING TO ALL 
THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT.    IF YOU DO NOT ACCEPT THESE 
TERMS WE ARE UNWILLING TO LICENSE THE SOFTWARE TO YOU AND YOU SHOULD NOT USE 
THE SOFTWARE.    IN SUCH CASE, YOU MAY, WITHIN FIFTEEN (15) DAYS, RETURN THE 
PRODUCT COMPLETE TOGETHER WITH PROOF OF PURCHASE TO THE PERSON FROM WHOM 
YOU ACQUIRED IT FOR A FULL REFUND.

SOFTWARE LICENSE AGREEMENT
A. You own only the media on which the Software or music is recorded.    Like a music CD or LP, you own 
the physical copy, but not any rights to the recorded material.    We continue to own the copy of the 
Software contained in this package and all other copies that you are authorised by this Agreement to 
make.    This license gives you the non-exclusive, non-transferable right to use the Software on the 
following terms:

B. YOU MAY
1. Use one copy of the Software on any single computer, subject to the provisions below.    The Software 
is "in use" on a computer when it is loaded into the temporary memory or installed in the permanent 
memory of that computer.    
2. May make one (1) backup copy of the Software, provided that you reproduce all copyright and other 
proprietary notices on the copy and the copy is kept in your possession with the original.
3. Distribute the Software on a public bulletin board or on CD ROM cover disks on various magazines.

C. YOU MAY NOT
1. Simultaneously use the Software on more than one computer at a time, regardless of whether such 
computer is a standalone unit, a portable unit or part of a computer network.
2. Rent, lend, lease, sell, transfer or grant any rights in the Software or accompanying documentation or 
distribute the Software for any marketing purpose or to your commercial advantage (except as allowed 
above).
3. Remove any copyright or other proprietary notices on the Software and accompanying documentation.
4. Modify, alter, translate or create derivative works based on the Software.
5. Copy (except as allowed above) the Software or the accompanying documentation.
6. Use any backup copy of the Software (or allow someone else to use such copy) for any purpose other 
than to replace the original copy in the event it is destroyed or becomes defective.
7. Reverse engineer, decompile, disassemble or otherwise attempt to derive the source code, except as 
local law may permit you to do so, notwithstanding such restrictions.
8. Use this software in a mode of operation where the Software is unattended by an operator for any 
purpose whatsoever, other than for personal use.
9. Use this software for any form of public broadcast or public performance.
10. Make MIDI file recordings or other recordings of the Koan piece or MIDI file where the original piece 
author has NOT authorised MIDI file recordings of their piece.
11. Distribute any of the Koan files, Albums, MIDI files or recordings that come with the Koan Pro or Koan 
Plus packages.

D. LIMITED WARRANTY

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION (EXCLUDING THE MEDIA ON WHICH 
THE SOFTWARE IS RECORDED) ARE LICENSED ON AN "AS IS" BASIS WITHOUT ANY WARRANTY 
WHATSOEVER.    We warrant that the software media will be free from defects in materials and 
workmanship under normal use for a period of 90 days from date of purchase.    If the media is defective, 



you may as your sole and exclusive remedy, send it to us during the warranty period by pre-paid postage 
to the address set forth below, together with a copy of your sales receipt, and we will send you 
replacement media.    
THIS WARRANTY GIVES YOU SPECIFIC RIGHTS.    DEPENDING ON LOCAL LAW, CERTAIN 
LIMITATIONS CONTAINED IN THIS WARRANTY MAY NOT APPLY TO YOU OR YOU MAY HAVE 
OTHER RIGHTS, SO BE SURE TO CHECK.    THIS WARRANTY IS GIVEN IN LIEU OF ALL 
WARRANTIES, CONDITIONS, TERMS, UNDERTAKINGS AND OBLIGATIONS IMPLIED BY STATUTE, 
COMMON LAW, CUSTOM, TRADE USAGE, COURSE OF DEALING OR OTHERWISE, ALL OF WHICH 
ARE HEREBY EXCLUDED TO THE FULLEST EXTENT PERMITTED BY LAW.    WE SPECIFICALLY 
DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE.

E. LIMITATION OF LIABILITY

OUR TOTAL LIABILITY TO YOU FOR ANY LOSSES WILL BE LIMITED TO DIRECT DAMAGES, AND 
SHALL NOT EXCEED THE PURCHASE PRICE OF THE SOFTWARE.    NEITHER WE NOR OUR 
SOFTWARE SUPPLIERS, DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES, WILL BE LIABLE 
FOR ANY INDIRECT, CONSEQUENTIAL, SPECIAL    OR INCIDENTAL DAMAGES, SUCH AS 
DAMAGES FOR LOST PROFITS, BUSINESS INTERRUPTION OR LOSS OF DATA ARISING OUT OF 
THE USE OF THE SOFTWARE OR THE ACCOMPANYING DOCUMENTATION, WHETHER OR NOT 
WE HAVE BEEN NOTIFIED OF THE POSSIBILITY OF SUCH DAMAGES.    

F. GENERAL TERMS

All rights not expressly granted to you hereunder are reserved by us. This license is effective until 
terminated.    Unauthorised copying of the Software or the accompanying documentation, or failure to 
comply with any provisions of this license, will result in automatic termination of this license and may 
result in legal action.    Upon termination, you agree to destroy all copies of the Software and the 
accompanying documentation in your possession.

- The enclosed Software and documentation are provided with restricted rights.    Any use, duplication or 
disclosure by the U.S. Government or any agency thereof is subject to restriction as set forth in 
subdivision (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 48 CFR 252-227-
7013 and in subdivision (b)(3)(ii) of The Rights in Technical Data and Computer Software clause at FAR 
52.227-7013.    Similarly, any use, duplication or disclosure by any other government is subject to similar 
restrictions under local law.
- In the event of any conflict between any provision of this Agreement and any applicable law, the 
provision or provisions of this Agreement affected shall be modified to remove such conflict and permit 
compliance with such law, and as so modified this Agreement shall continue in full force and effect.
- This Agreement shall be governed by the English law [and shall be subject to the exclusive jurisdiction of
the English courts] without reference to conflicts of laws principles.    This Agreement constitutes the entire
agreement between the parties with respect to the Software and the accompanying documentation [and 
supersedes any prior purchase order, communications, advertising or representations concerning the 
Software and accompanying documentation] and may not be modified other than by an instrument in 
writing signed by both parties.

REMEMBER TO SIGN AND MAIL THE REGISTRATION CARD TODAY!

IF YOU HAVE ANY QUESTIONS ABOUT THIS LICENSE OR THIS LIMITED WARRANTY, PLEASE 
WRITE TO OUR CUSTOMER SERVICE DEPARTMENT AT SSEYO Ltd, P.O. BOX 29,    
BEACONSFIELD, BUCKS, HP9 1EB, UK.





File Menu commands

The File menu offers the following commands:

New Creates a new album.
Open Opens an existing album.
Save Saves an opened album using the same file name.
Save As Saves an opened album to a specified file name.
File 1, 2, ... Opens specified album.
Exit Exits Koan Plus.



Edit Menu commands

The Edit menu offers the following commands:

Add Adds a new piece to the open album.
Cut Deletes a piece from the album and moves it to the 

clipboard.
Copy Copies a piece from the album to the clipboard.
Paste Pastes a piece from the clipboard into the album.



Control Menu commands

The Control menu offers the following commands:

Play Plays the piece that is in the active window.
Stop Stops the currently playing piece.
Previous Plays previous piece.
Next Plays next piece.
Fast Forward Fast forwards through the currently playing piece.
Rewind Rewinds through the currently playing piece.
Random Play Turn on to play pieces in the album in random order; turn 

off to play pieces sequentially.
Mute All Mutes the currently playing piece.
Save Knob 
Settings

Saves your knob settings.

Restore Knob
Settings

Restores all your knob settings back to values you have 
saved previously.



Options Menu commands

The Options menu offers the following commands:

Setup Defines the time over which you allow Koan Plus to 
compose and lists options like auto-play.

Record MIDI 
File

Records MIDI information to a file.

Master 
Control 
Settings

Use these controls to adjust the volume and stereo 
balance of a piece (and reverb and chorus if your 
soundcard supports it).

Album Notes Hides or displays the Album notes window.
Piece Notes Hides or displays the Piece notes window.



Window Menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Show Player Shows or hides the Player module.

Show Graphic 
Analyser

Shows or hides the Analyser module.

Show Album 
Viewer

Shows or hides the Viewer module.

No Title Shows or hides the main title bar and menus.



Help Menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Search Calls up the Help Search facility to look for keywords.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new album in Koan Plus.

Note:    Only one album can be open at a time in V1.0.    Creating a new album will close any other open 
album.

You can open an existing album with the Open command.

Shortcuts

Player module:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing album. Koan Plus comes with 3 albums, located in the KOANALB 
directory.

You can create new albums with the New command.

Note: Only one album can be open at a time.    Opening an album will close any other open album.

Shortcuts

Player module:

Viewer module:

Keys: CTRL+O



File Open dialog box

The following options allow you to specify which album to open:
File Name

Type or select the album name you want to open (Koan Plus comes with 3 albums, located in the 
KOANALB directory).

List Files of Type
Koan Plus will only read/open files with the extension .SKA (SSEYO album format).

Drives
Select the drive in which Koan Plus stores the file that you want to open. 

Directories
Select the directory in which Koan Plus stores the file that you want to open (Koan Plus comes with 3 
albums, located in the KOANALB directory).

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

Note: Only one album can be open at a time.    Opening an album will close any other open album.



Close command (File menu)

Use this command to close all windows containing the active album.    Koan Plus suggests that you save 
changes to your album before you close it.    If you close an album without saving, you lose all changes 
made since the last time you saved it.    Before closing an untitled album, Koan Plus displays the Save As 
dialog box and suggests that you name and save it.



Save command (File menu)

Use this command to save the active album to its current name and directory.    When you save an album 
for the first time, Koan Plus displays the Save As dialog box so you can name your album.    If you want to
change the name and directory of an existing album before you save it, choose the Save As command.

Shortcuts

Player module:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active album.    Koan Plus displays the Save As dialog box so 
you can name your album.    

To save an album with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the album you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of three characters.    Koan Plus adds the extension you specify in the 
Save File As Type box, but you should only save your album as a .SKA file (SSEYO album format).

Drives
Select the drive in which you want to store the album.

Directories
Select the directory in which you want to store the album.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four albums you 
closed.    Choose the number that corresponds with the album you want to open.



Exit command (File menu)

Use this command to end your Koan Plus session.    You can also use the Close command on the 
application Control menu.    Koan Plus prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.



Redo command (Edit menu)

Koan Plus will do your last issued command again.



Add command (Edit menu)

Adds a new piece to the currently open album.    

The following options allow you to specify which piece to add:
File Name

Type or select the piece name you want to add.
List Files of Type

Koan Plus will only add files with the extensions .SKD or .SKP.    These files are pieces created with 
Koan Pro which saves them in either the .SKD format or the encrypted .SKP format.

Drives
Select the drive in which Koan Plus stores the piece that you want to open. 

Directories
Select the directory in which Koan Plus stores the piece that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

Shortcuts

Main control panel:
Keys: CTRL+A



Cut command (Edit menu)

Use this command to remove the currently selected piece from the album and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Main control panel:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected piece onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Main control panel:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents (a piece) at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Main control panel:
Keys: CTRL+V



Play command (Control menu)

Use this command to play the piece in the active window.

Shortcuts

Player module:
Keys: CTRL+P



Stop command (Control menu)

Use this command to stop the piece currently playing.

Shortcuts

Player module:
Keys: CTRL+T



Pause command (Control menu)

Use this command to pause the piece currently playing.

Shortcuts

Player module:
Keys: CTRL+U



Previous command (Control menu)

Use this command to play the previous piece.

Shortcuts

Player module:
Keys: CTRL+R



Next command (Control menu)

Use this command to play the next piece.

Shortcuts

Player module:
Keys: CTRL+E



Fast Forward command (Control menu)

Use this command to move quickly forward through the playing file.    The piece will increment forward by 
10% each time this command is used.

Note:    The piece does not actually rewind as Koan pieces do not operate in this way.    What happens is 
that the piece characteristics will be adjusted to new values appropriate for the new elapsed piece time.

Shortcuts

Player module:
Keys: CTRL+F



Rewind command (Control menu)

Use this command to move quickly backwards through the playing file.    The piece will rewind by 10% 
each time this command is used.

Note:    The piece does not actually rewind as Koan pieces do not operate in this way.    What happens is 
that the piece characteristics will be adjusted to new values appropriate for the new elapsed piece time.

Shortcuts

Player module:
Keys: CTRL+B



Random Play (Control menu)

Use this command to play the pieces in the album in random order or sequentially. 

Shortcuts
Player module: Random

Ordered



No Title command (Window menu)

Use this command to hide the Koan Plus Title bar and menus.    Press the Escape key to bring them back 
or toggle them on/off.

Shortcuts
Mouse: Double-click on any of the Koan Plus modules
Keys: ESC



Show (or hide) Player/ Analyser/ Viewer (Window menu)

Used to show or hide any of the Koan Plus modules (with the exception of the Main Control module, see 
below).    The display buttons are located on the Main Control module (and they double up as display/ 
hide buttons) and the Hide buttons are on the modules themselves.    When you hide a module Koan Plus 
remembers this when you next run the program.

When a module is hidden its corresponding display button will be in the up position, ready to be 
depressed.    When a module is open its corresponding display button will be greyed and shown as 
depressed.    

Note: The Hide button has special significance on the Master Control Module as it closes down the 
Koan Plus application.    It is in effect a master power button.

Shortcuts

Display modules:     

    

Hide button:



Toolbar command (Windows menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Koan Plus, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (Window menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



New Window command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Koan Plus displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Koan Plus and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Search command (Help menu)

Use this command to search for topics on which you require help.



Using Help command (Help menu)

3 types of help are available:

1 Press F1 to bring up the Help Contents screen at any time

2 Press Shift F1 to bring up the context sensitive help arrow which you can click on an item or menu 
on which you want help (alternatively, press the Help button on the Master Control Module).

3 Use the Help menu to call up the Search Dialog or the Help Contents screen.



About command (Help menu)

Displays the copyright notice and version number of your copy of Koan Plus.



Context Help command 

Use the Context Help command to obtain help on some portion of Koan Plus.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Koan Plus window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut

Main control panel:
Keys: Shift+F1



Minimize command (Application Control menu)

Use this command to reduce the Koan Plus window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Koan Plus determines which window 
is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Koan Plus determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the album window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (Application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

<< Write application-specific help here. >>



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button





Koan Plus Help Contents

Above:    Quick Help for the interface: click anywhere on image for help.

Important notes on Koan Plus Demo: 
IMPORTANT NOTICE: CAREFULLY READ THE LICENSE BEFORE USING THE SOFTWARE AND ACCOMPANYING 
DOCUMENTATION.    BY USING THE SOFTWARE YOU ARE AGREEING TO ALL THE TERMS AND CONDITIONS OF THE 
LICENSE AGREEMENT.

Koan Plus Demo will play for 10 minutes before displaying a message saying you have another 5 minutes before the product will 
stop playing.    To restart simply press the play button or select Play from the Control menu.    The Demo pieces are a selection of 
those in Koan Plus, but have had their play times reduced.

The Koan Plus Demo On-line help is virtually the same as Koan Plus help, allowing you to see the functionality you would get if you 
purchase the full version.

Quick Start
Introducing Koan Plus
Guide to Koan Plus modules
Quick Tutorial
Albums and Pieces included with Koan Plus
MIDI file recording

Menu Commands
File menu
Edit menu
Control menu
Options menu
Window menu
Help menu

Further information
PC Configuration
Setting up your MIDI MAPPER
Setup Options
Comparable products
Copyright issues
Software License
SSEYO

Koan Plus     Koan Pro 





Koan Plus main display

Koan Plus consists of a Main Control module plus 3 others:    Click on the items below to go to the 
appropriate help section.

Main Control Module

The Main Control module contains all the buttons for displaying the other.    Koan piece will continue 
playing when only this module is displayed.    To Close the Koan Plus application press the Power button 
or choose File Exit from the menu.

Player Module

Used to play Koan Albums and Pieces

Viewer Module

Used to view Album and Piece notes

Analyser Module

Used to see more details on Koans musical progress

                                  
See also
Tutorial



Setup Options command (Options menu)

Koan Plus Auto Play
Checking this box will mean every time you start Koan Plus the album you had loaded when you closed 
Koan    will be reloaded when you next start Koan .    It will then start playing automatically.    (See also 
Running Koan Plus Minimised).

COMPOSER
The Composer sets the time for which the composer engine looks ahead, and the past period over which 
it will carry harmony etc. relationships.

Reaction Time The amount of time in milliseconds (ms) the Composer has over which to compose.  
The larger the value the more it can compose ahead, which is very useful for slower 
machines and if you want to do a lot of processor intensive work, i.e. displaying a 
screenshow.    If you use a small value for Reaction Time and take the focus away 
from the program, i.e. hold down the mouse, the output can stop.    It will resume 
when the focus passes back to Koan Plus.
Normally set to 10,000 ms ( i.e. 10 seconds).
Note: The resolution on this value is one bar of music, meaning that it will always 
compose at least one bar in advance.

History Time The period over which harmony relationships will hold good for long notes.    
Normally set to 20,000 (ms) (i.e. 20 seconds).

CONDUCTOR
Roughly speaking, the Conductor determines what how hungry Koan Plus is for your PC system 
resources.      The bigger the value of Resolution and Cycle the smoother the truly Ambient pieces sound 
as there is less precision required in the composition, however, it is generally best to use smaller values, 
which are required for the more rhythmic pieces.

Low Priority Means Koan  is less likely to take system resources; can mean pieces sound 
smoother as there is less rigorous control of timings.    However, this can have a 
detrimental effect on highly rhythmic pieces.

High Priority If on High Priority at high Resolution (i.e. low actual ms (millisecond) value) Koan  
will take as much system resources as it needs - highly rhythmic pieces require this. 
This can cause other applications to run slower.

Resolution In conjunction with the Cycle parameter below, determines how accurately Koan  
conducts its pieces/ sends out its MIDI information.    Resolution is the tolerance on 
the Cycle value.    This means Koan    will send out MIDI information every Cycle +/- 
the Resolution.

Cycle This is the period in milliseconds between timer events, i.e. how often Koan  
composes/ sends out the MIDI information.    Small values for Cycle (10 ms or less) 
mean the pieces will be very accurate time wise (important for rhythmic pieces), 
however this can sometimes be at the expense of some smoothness, especially on 
slower machines.    Very small values of Cycle and Resolution can cause your PC 
to slow down their processing of other applications.

Note 1: Changes to the Composer or Conductor are only implemented when a piece is started.

Note 2: The values set here will be used by Koan Plus to play any piece you might load, so in some 
circumstances it may be necessary to alter them.    You will be able to identify this if the piece 



sounds jumpy or seems to give you bursts of notes.    In this case try to increase the reaction time 
first and then raise or lower the values for cycle/ resolution. Once set, to your satisfaction 
however, they should not require frequent adjustment.



Running Koan Plus Minimised

You may want to set up Koan Plus so that it loads your last album automatically, starts it playing and then 
minimises to an icon.    This means you never actually see Koan Plus full screen (unless you maximise 
the application).    You may wish to do this if all you want to do is listen to your favourite album with the 
minimum of effort.    You could even then put the Koan Plus icon in your Startup program group so that 
everytime you turn on your machine Koan Plus kicks off playing behind the screens.

To setup Koan Plus to run minimised do the following:

1 Select Setup Options and check the Autoplay box
2 From the Program Manager select the Koan Plus icon and choose File Properties.
3 Make sure the Run Minimised box is checked and press OK.

________
See also
Setup Options Command
Always on Top



Always on Top (System Menu)

This feature allows you to force Koan Plus to always display on the screen, no matter what other 
applications you are running.    The option can be selected to toggle it on and off.

________
See also
Running Koan Plus Minimised



Master Control Knobs/ Settings Command (Options menu)

These controls override, but do not alter any piece level settings that may be provided within the piece.    
They are additive in that they add a uniform amount to the value of this parameter for each instrument in 
the piece.    Simply click on any knob (or slider if working off the menu option) with the mouse and drag 
the control setting to a new value, then release the mouse for the setting to take effect.

Volume Sets the master volume (actual value shown on Player LED display).
Pan Sets the master stereo/ pan position of the output (actual value shown on Player LED 

display).

Reverb Sets master reverb level (actual value shown on Player LED display).
Chorus Sets master chorus level (actual value shown on Player LED display).

Note 1: Reverb and chorus settings will only have any effect on soundcards/ synths that support 
them.

________
See also
Restore Knob Settings
Save Knob Settings



Font command (Options menu)

Allows you to determine the font you use for Koan Plus.    Koan Plus comes with a default setting of Arial 
10 point.



Mute All command (Options menu)

Mutes or resets back to normal the currently playing piece.    As well as the Mute All button toggling 
between on and off states, the LED display will indicate whether mute is on or off as well.

If the Analyser module is open when the piece is muted and it is set to display MIDI channel information, 
then all the channels will be shown as being muted.

Note:    How quickly this button acts to mute the piece depends on how far in advance you are composing.

Shortcuts
Player (mute on):

Player (mute off):
Keys: CTRL+M



Save Knob Settings command (Control menu)

Allows you to save your volume, pan and tempo settings (and reverb and chorus settings if your 
soundcard supports them).    When saved you can then apply them as the default settings as you wish.

The user control settings work on the principle of adding/ subtracting your settings to the values provided 
in the playing piece.    If you turn the knob to the left you will be reducing that value; if you turn it to the 
right you will be increasing that value.    To hear the piece as it was intended it is best to only adjust the 
volume and pan settings to suit your system, and leave the other controls set at mid value.

Shortcuts
Player module:

________
See also
Restore Knob Settings



Restore Knob Settings command (Control menu)

Will reset all volume, pan and tempo settings (and reverb and chorus settings if your soundcard supports 
them) back to the values saved previously.

The user control settings work on the principle of adding/ subtracting your settings to the values provided 
in the playing piece.    If you turn the knob to the left you will be reducing that value; if you turn it to the 
right you will be increasing that value.    To hear the piece as it was intended it is best to only adjust the 
volume and pan settings to suit your system, and leave the other controls set at mid value.

Shortcuts
Player module:

________
See also
Save Knob Settings



Album Notes command (Option menu)

Pressing the Album Notes button calls up the Album notes window where you view notes provided about 
the album.    Alternatively you can create your own album and add your notes here.

Note: Remember that the copyright on the Album notes belongs to the artist who compiled the album and
wrote the notes.    This may or may not be the same as the Copyright holder of the Piece who is detailed 
in the Piece, and who is shown in the Album contents window.

Shortcuts

Viewer module:
                 
See also
Piece Notes



Piece Notes command (Options menu)

Pressing the Piece Notes button calls up the Piece notes window where you view notes provided about 
the piece.    These notes are provided by the author and are not editable, however, you may copy the text 
to another file.

Recording Rights
Every piece you have in your possession will have been authored by someone.    When they save the 
piece they have created they can choose two options.    One is to choose whether or not they will allow 
you to be able to record the output to a MIDI file should you so desire, and the other is to decide whether 
or not they are prepared to relinquish all rights in and title to MIDI file or other recordings of their piece.    If
they do, then you can record it and you own the copyright on any recordings you may make.    Please 
refer to copyright for further clarification.

Note: Remember that the copyright on the Piece notes belongs to the Copyright holder detailed in the 
Piece.

Shortcuts

Viewer module:
                 
See also
Album Notes



Analyser MIDI Display command (Windows menu)

Toggles between one of 2 types of display:      MIDI Channel / Frequency Spectrum 

MIDI Channel display:
16 LED bars are shown, one for each MIDI channel. Each bar shows the relative volume of each note 
played on that channel and gives a good visual indication of the activity going on on that channel.

Frequency Spectrum Display:
16 LED bars are shown, spanning the range of around 10 octaves, indicated by the keyboard display 
below the LED bars.    Middle C is indicated on the keyboard by a pink key, and each octave is separated 
by a green key.    The bars show the relative volume of each note played within their related keyboard 
range and give a good visual indication of the frequency balance of the piece.

Note: It is possible that some notes played by your sound source may continue to play whilst the 
display shows them to have faded away. Each meter responds to note on information in the MIDI stream 
and it assumes that all notes played have a natural decay curve.    This will be correct for most types of 
instrument but it is possible that some instruments in the piece may play very long notes which hold their 
volume.    In this instance you would see the note fade away but still hear it.      For instance, an artist 
might decree that one of the instruments in the piece plays a pad - a soft sound which on a normal 
synthesiser will play for as long as a key is depressed - for a period of 20 seconds.    Even though you will 
see the note displayed in the LED bars for a short while it will continue to play on for around 20 seconds.

Shortcuts
Analyser module:  

                 
See also
Koan Plus Analyser Module



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Koan Plus,

To hide or display the Toolbar, choose Toolbar from the Window menu (ALT, W, T).



Status Bar

The status bar is displayed at the bottom of the Koan Plus window.    To display or hide the status bar, 
use the Status Bar command in the Window menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

Not yet determined*******
The illustrated areas of the status bar indicates various piece statistics:

Indicator Description
1st box Tempo of the piece in beats per minute.

2nd box Time signature of the piece, i.e. 4/4.

3rd box Time the piece has been playing in minutes:seconds.

4th box Time the piece has left to play in minutes:seconds.



Koan Plus Main Control module

This module is the control centre.    It allows you to launch the various modules that are part of Koan Plus. 
To close the Main Control module either press the power button or select File Exit from the menu.

There are two LED panels, the first displays the currently playing (or loaded) piece, and the second the 
currently loaded album.

The light on the Master Control Module will flash when a piece is playing.

When a module is open the appropriate module button will be grayed; conversely when the module is 
closed the button will be up and ready to be pressed.

Tip: To see the menus double click with the mouse on any of the modules.

Click To

Close down the Koan Plus application.

Context sensitive help.

Display/ Hide the Koan Plus Player module

Display/ Hide Koan Plus Viewer module

Display/ Hide Koan Plus Analyser module



Koan Plus Player module

The Koan Plus Player module is the major module in the application.    It allows you to play Koan pieces 
and has controls similar to a CD player.

Main LED panel
The LED panel which graphically displays information about the piece and its current status.
The maximum combined volume of all the playing instruments is set with Volume knob.    The Pan knob 
adjusts the stereo position.    The Pan and Volume information is displayed in the Left and Right LED 
displays.

A moving piece played marker shows how long the piece has been playing for.    Above this is shown the 
playing Track number, how long it has been playing and its total play length.

Below this is the trailing display showing the piece name.    This scrolls across the screen and can be 
turned on and off by clicking on it.

The piece tempo is also displayed and is labelled BPM (beats per minute).    Some pieces have tempos 
that change during the piece and this is reflected in the values shown.

There are also a number of controls you can click in this panel (see below ).
Save/ Restore Knob settings

Knob controls
See the section on Master Controls Knobs for information about them.
Note: Adjusting the Volume knob when the Mute facility is selected will automatically turn it off.

Click To

Hide the Player window.

Open an existing album.

Play the previous piece.

Rewind the piece that is currently playing in 10% increments.

Play the currently selected piece.

Fast forward the currently playing piece in 10% increments.

Play the next piece.

Stop the currently playing piece.

Call up the MIDI file record dialog.

Cause the pieces in the album to be played in track order.

Cause the pieces in the album to be played in random order.

Mute all the instruments playing in the current piece.



User knob settings are saved.

Restore the knob settings to the values you have previously saved.



Koan Plus Analyser module

The Koan Plus Analyser module is designed to allow you to see more deeply into what is happening with 
the music, and provide a pleasant moving indicator coupled to the piece output.

It comprises a power button, a display toggle button and an LED display panel.

Click To
Hide the Analyser window.

Toggle you to the MIDI line display.

Toggle you to the Frequency display.



Koan Plus Viewer module

The Koan Plus Viewer is there to let you see what pieces are in your album or to create new albums into 
which you can place pieces.    It includes a main window in which the relevant abbreviated piece 
information is displayed, namely the name of the piece, the author, its length and its filename together 
with various buttons for editing albums.

Click To
Hide the Viewer window.

View/ edit the album notes.

View the piece notes.

Open an existing album.

Create a new album.

Save the active album with its current name.    If you have not named the album, Koan Plus 
displays the Save As dialog box.

Add a piece to the currently open album.

Remove a selected piece from the album and stores it on the clipboard.

Copy the piece selected to the clipboard.

Insert the piece currently in the clipboard at the insertion point.





Quick Tutorial

Koan Plus is a very easy to use product as it is rather like a CD player.    It is so easy to use you should 
not even need to look at this tutorial!    However, before you do read the tutorial it is best to get a quick 
understanding of what Koan Plus DOES, so we recommend you have a short browse of the Introduction.

Koan Plus will play back beautiful ever-changing mood music, and all you have to do to get this to happen
is load an album and play it!    First of all, though,    it is necessary to familiarise yourself with the display 
modules, what they look like and what they do.

Clicking on any of the buttons in the tutorial will take you to a more in depth explanation of the 
item in question.

We are assuming you have correctly installed your soundcard and have had no problems 
installing Koan Plus.

1 The Modules

Main Control Module

 
Player Module

 
Viewer Module

 
Analyser Module

Showing and Hiding modules
Press the above button in any module to hide it.    Doing so will not stop an album playing.    Note that you 
can also setup Koan Plus to run minimised.

2 Opening, playing and closing
Opening an Album

Koan Plus comes with 3 albums each containing a number of pieces. These albums and pieces are to be 
found in the KOANALB directory.    It is possible when you first load Koan Plus one of these albums will 
already be loaded for you.    If not, follow the normal File Open procedure from the menu or use the click 
the Open button (above) on the Player module (or the Viewer module). 

Tip: To see the menus double click with the mouse on any of the modules.

Note: Only one album can be open at a time.    Opening an album will close any other open album.

Playing an piece or album
Press the Play button on the Player module or select Control Play from the menu.    Either the first piece in
the album or the piece that is highlighted in the Viewer or will then play, depending on whether or not you 
have opened the album earlier. You can double click on a piece to cause it to play, too.

Next piece in an album
To go to the next piece and play it either press the Next piece button or select Control Next from the 
menu.    



Previous piece in an album
To go to the previous piece and play it either press the Previous piece button or select Control Previous 
from the menu.

Fast fowarding a piece
Press the Fast Forward button to scroll through the currently playing piece or select Control Fast Forward 
from the menu.

Rewinding a piece
Press the Rewind to scroll back through the currently playing piece or select Control Rewind from the 
menu.

Stopping a piece
Press the Stop button or select Control Stop from the menu.

Recording a MIDI file
Koan Plus allows you to record its output as a type 1 MIDI file (see discussion on copyright).    You get the
best results by following the steps below:

1 Start the record process by pressing the Record button.
2 Start the piece playing which you want to record.
3 Stop the piece playing
4 Stop recording the piece and close the MIDI file record dialog.

3 Albums and Pieces
Press the Album button or the Piece button to view the Album or Piece notes respectively, or alternatively 
select Control Album or Control Piece from the menu.    

Piece notes
In the Piece notes window is displayed more information, as supplied by the author, about the piece itself. 
You can not edit any of this information.    The playing piece is always identified by the green arrow in the 
Viewer display area.

Album notes
Type your details into the edit album field and add your notes to where it says edit album notes and press 
OK.    Remember to save your album.

Opening an album
To open an album either select File Open from the menu or press the Open button.

Creating a new album
To create a new album either select File New from the menu or press the New button.

Saving an album
To save an album either select File Save or File Save As from the menu or press the Save button.

Adding pieces to an album
To add a piece to an album either select Edit Add from the menu or press the Add button.

Cutting pieces from an album
To remove a piece from an album select Edit Cut from the menu or press the cut button.

Copying pieces in an album
To copy a piece from an album to the clipboard select Edit Copy from the menu or press the Copy button. 
You can then Paste it back in to duplicate the piece.



 Pasting pieces in an album
To paste a piece from the clipboard select Edit Paste from the menu or press the Paste button.

4 Knobs (volume, pan, reverb and chorus) and other controls
Use a mouse to move the Player control knobs (by clicking on the place where you want the control to go 
or by dragging the position marker) to adjust your volume/ pan/ reverb/ chorus /tempo values in real-time. 
Changing these controls also affects the levels displayed in the Analyser and Left and Right level 
displays, as you would expect.

Note: Reverb and chorus are only supported by certain soundcards - check your soundcard manual.

 
Mute All

Press the button in the Player LED panel to instantly mute the playing piece.    When the piece is muted 
the button will display with a line through it.

    
Ordered/ Random piece play

Press the button in the Player LED panel to toggle between random piece play (213), where any piece in 
the album can be chosen to play, or ordered piece play (123) when it will play each piece in turn.

Save Knob Settings
Press the button in the Player LED panel to save your volume, pan, reverb and chorus settings to be the 
defaults.

Note: Reverb and chorus are only supported by certain soundcards - check your soundcard manual.

Restore Knob Settings
Press the button in the Player LED panel to apply previously saved knob settings.

Note: Reverb and chorus are only supported by certain soundcards - check your soundcard manual.



Koan Plus requirements

Requirements

Koan Plus requires a 386/486 (or higher) based computer with a minimum 2Mb hard disk space and 2Mb
RAM (some rhythmic pieces require a faster 486).    You need to be running Windows    3.1.      There are 
no special display requirements.    You may use any sound card or MPU401 MIDI interface that can 
connect to the    Windows MIDI mapper (refer to your Windows manual for details on the MIDI Mapper).    
This noted, Koan Plus will sound the best if you are using a high end sound card or external 
synth/sampler; this is because the quality of the sound scapes produced is generally only limited by the 
sound quality of your sound card/ synthesizer.

Note: We recommend you use the MIDI Mapper, but we will pick up any other Windows MIDI driver if 
the MIDI Mapper is not installed.

Minimum (for non-rhythmic pieces)
33MHz 386 DX PC
2Mb RAM
DOS 3.0 or later
Windows 3.1
Mouse
3.5" 1.44Mb floppy drive for installation
2Mb free hard disk space
A PC sound card/MIDI interface with an installed Windows MIDI driver

Strongly Recommended (for all pieces)
33MHz 486 PC (or greater)
4Mb RAM
DOS 5.0
Windows 3.1
Mouse
3.5" 1.44Mb floppy drive for installation
3Mb free hard disk space
PC soundcard/ MIDI interface with MIDI Mapper support and with the best quality sound 

synthesiser - Wavetable or LA

Note:  Koan Plus supports the General MIDI standard, and all instructions assume your sound card or 
synth does, too.    



Installing Koan Plus

Note:  Before installing the software we recommend you take a backup copy of the Koan Plus disk, 
in case you lose or damage the originals. Use the DOS DISKCOPY command.

1. Insert the Koan Plus disk into your floppy disk drive
2 Select Run from the File Menu of the Program Manager
3 Enter the following:

drive:\SETUP.EXE 
where drive is the drive letter of your floppy drive.

4 Choose your installation directory (we recommend you use the default \KOAN) and press Continue.
The installation will now take place and a program group will be made for you.

u If you have not already set up the Windows MIDI Mapper for your sound card, follow the 
instructions given in the manual that came with it or refer to the MIDI Mapper    help topic.



Setting up the MIDI Mapper

Note: We recommend you use the MIDI Mapper, but we will pick up any other Windows MIDI driver if 
the MIDI Mapper is not installed.

General reference

The MIDI Mapper is a very useful Windows utility and it makes it easier for software to communicate with 
your sound card or MIDI interface card.    It acts as an intermediary through which Koan Plus talks to your 
sound card.    It basically one big patch map (or post office) which allows you to match up your sound card
with any software generating a MIDI output. Koan Plus supports the General MIDI standard, so, if not 
already set-up in this mode,    you will need to set up the MIDI Mapper to match this standard. 

Incidentally,    Windows 3.1 supports a    number of sound cards/devices, and    these are currently the 
Creative Labs Sound Blaster v1.0/ v1.5, Roland MPU401, Roland LAPC1, Ad Lib, Media Vision Thunder 
Board etc. If your card/interface is not apparently supported by Windows then the card/interface 
manufacturer should produce a 'driver' that allows it to talk to the MIDI Mapper.    To see the list of drivers 
supported (and to make sure your sound card is configured properly) select the Drivers icon in the 
Program Manager Control Panel.    If your card is not already set up, refer to the card/interface maker's 
instructions.

The MIDI Mapper comes with 4 patch maps as standard; MT32, MT32 perc, Prot/1 and Prot/1 perc.    The 
MT32 perc is actually set up as the General MIDI patch map (quite obvious really), but for the example 
below we are going to assume that you have a Roland SCC1 card fitted, and you need to create a patch 
map for this card.

We have chosen this card to represent the case of those cards which do not have a preset setup in the 
MIDI Mapper.    Although you may be able to follow the example, we do recommend that you have a quick
read through the section on the MIDI Mapper in the Windows manual before proceeding. 

Note:    You should also follow the instructions provided by the supplier of your sound card/interface, 
because you    may need a    special set-up for some cards.    SoundBlaster, MediaVision and similar cards
do not always support the 128 General MIDI sounds.

Double click on the Control Panel icon in the Program Manager, and then double click on the MIDI 
Mapper (if there is no MIDI Mapper, then you have not properly set-up your sound card, or there is no 
sound card installed - refer to the Windows manual).

Windows 3.1 MIDI Mapper

Select Show Patch Maps and open the Name drop box.    You will see there is no General MIDI set-up up 
so we are going to create one.    

Select New and    in the Name and Description boxes type General MIDI, then press OK.

You are presented with a table with the headings Src Patch, Src Patch Name, Dest Patch, Volume %, and
Key Map name.    We want to set up a General MIDI patch map, and this entails matching the Src Patch 



to the Dest Patch.. Kindly, this is the default.    Press the button at the top (which toggles between '1 
based patches' and '0 base patches') so that the first Src patch is 1, which corresponds to acoustic grand 
piano.    Make sure the Key Map name is 'none' and press OK.

Next, select Show Setup and open the Name drop box.    You will see there is no General MIDI set-up 
(however, Extended MIDI really is General MIDI, without the Patch Map set up properly!)    so we are 
going to create one.    

Select New and    in the Name and Description boxes type General MIDI, then press OK.

You are presented with a table with the headings Src Chan, Dest Chan, Port Name, Patch Map Name 
and Active.    The Src and Dest Channel matchings are beyond the scope of this manual, but we are going
to pair 1 with 1 , and 2 with 2 etc.    The Port Name is the driver you have set up to talk to your sound 
card.    

Go through each of the 16 Src Channels and set    Port Name to the driver your card is using (e.g. MIDI 
401 for the SCC1), and Patch Map name to the General MIDI patch map we have just made.    Make sure 
all of the Active boxes is ticked.

Note: Koan Plus requires that channel 10 is reserved for drums/percussion

Your sound card should now be ready to work with Koan Plus.





MIDI File Recording

MIDI File Recording functionality has been removed from the Koan Plus Demo version, and the 
description below is for Koan Plus, allowing you to see what you can do if you purchase the full product.

Either press this button or select MIDI file record from the Options menu. Use this command to record a 
Type 1 MIDI file of the currently playing piece.    Once you have recorded the file you can edit it in your 
favourite sequencer package.    Follow the steps in the order below:

Note:    Recording Rights
Every piece you have in your possession will have been authored by someone.    When they save the 
piece they have created they can choose two options.    One is to choose whether or not they will allow 
you to be able to record the output to a MIDI file (if they have done this then the MIDI file record check 
box will not be checked and you will be unable to record the piece).    The other is to decide whether or 
not they are prepared to relinquish all rights in and title to MIDI file or other recordings of their piece.    If 
they do, then you can record it and you own the copyright on any recordings you may make.    Please 
refer to copyright for further clarification.    

General Recording

1 Select Options Midi File Record from the menu.
2 Enter a file name and press OK.
3 Press the Start button in the MIDI record dialog FIRST and then start the Koan piece playing that 

you want to record.    This is to make sure you capture all the program change/ instrument selection
information (see note 1).

4 To record the same piece again just press the Name File button and choose a new name.
5 Stop the piece playing BEFORE you stop the MIDI file recording, as you will get hanging notes in 

the MIDI file (because they were never told to stop playing! - see note 2)
6 Stop the MIDI file recorded by pressing the MIDI file Stop button in the MIDI File Record Dialog.

Advanced recording
Using Pause when recording one piece in one MIDI file
To Pause the recording during a take, press the Pause button.    If your piece has loaded some new 
patches in the meantime they will not be loaded correctly when you play back your MIDI file because you 
have not recorded the Program change information.

Using Pause when recording multiple pieces in one MIDI file
Recording many pieces in one file is really neat because you can stitch together medleys of songs without
even the use of a sequencer package.    If you want to pause the recording of one piece and then load 
another to be recorded in THE SAME MIDI file make sure you follow the following procedure (assuming 
you are already recording a piece):

1 Press the Pause button in the MIDI File Record Dialog
2 Stop the currently playing piece.
3 Open the piece you want to record in the same MIDI file.
4 Start Recording again.
5 Start the new piece playing.
6 Repeat 1 to 5 for other pieces to be added to the file.
7 Stop your last piece playing



8 Press the Stop recording button
9 Close the MIDI File Record dialog

Note 1: It is always best to start recording before you play your piece to make sure you capture all 
the program change/ instrument selection information .

Note 2: If you do not stop Koan Plus playing before you stop the midi file recorder, and you then 
load up the midi file into your sequencer    you will hear/ see that the notes that were playing 
when you stopped recording, continue for ever. This is because pressing the midi file stop 
button does NOT stop Koan Plus playing. If you want to force all notes to stop in your Midi 
file, just stop Koan Plus before you stop the Midi File Record.

Note 3: Koan Plus can create pieces that have very slow tempos (e.g. less than 40).    Some 
sequencer packages may have trouble loading files with very slow tempos.

________
See also
Piece Notes





Albums

Koan Plus Demo comes with 1 album containing 3 pieces and no MIDI file recordings or audio recordings.

Koan Plus comes with 3 albums including a total of 10 pieces.    Koan Plus also comes with 10 MIDI file 
recordings of these pieces and the studio mastered audio recordings of these MIDI files.    Further albums 
are available from your distributor (see README.TXT for details of our distributors). Each album has its 
own short notes and contains a number of pieces.    Each piece contained in the album has its own Piece 
Notes in which the author has the opportunity to give a description of the piece or any other details they 
may want you to see.    






